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   This document is an introduction to Maple for Math 2250 students who may not have done previous 
work with this software, or who may just want to brush up on their skills.  An on-line version of this 
tutorial, without Maple output, is at  
http://www.math.utah.edu/~korevaar/2250fall08/2250mapleintro.mws

............................................................................................................................................
    These notes were created using the software package Maple in order to introduce you to Maple, but 
also to show you the kinds of documents you will be able to create yourself. 

     Although this software has been produced by a private company since 1988, it originated with 
Canadian government support at the University of Waterloo; the originators used the leaf on the 
Canadian flag to motivate the name "Maple."

     You will be using Maple in Math 2250, in order to solve problems and do computer projects.  You 
should think of this software as analgous to the service provided by Microsoft Word as a tool for writing 
papers - except Maple lets you create documents which combine text and mathematics.  Alternately, you 
may use Maple to generate mathematical output, which you can then export to other documents.  That is 
closer to how engineers use Matlab, which is more efficient than Maple at doing extremely large 
computations, but lacks Maple’s ability to create text documents and to easily do symbolic mathematical 
work.  Your specific assignments and required formats will depend on your particular Math 2250 
instructor.

     We recommend Maple 8 in Math 2250, because it has superior graphing capabilites over the more 
recent versions, which are Maple 11 and Maple 12.  The main advantage of these latter versions is that 
they include more Microsoft Word type bells and whistles.  Any Maple 8 document should open in 
Maple 11-12, but if you are using these latter Maple versions and you expect to reopen your document in 
Maple 8, you must save your file in the "classic" mode.  Student computers around campus 
(Engineering, Marriott, Math Department, Heritage Commons ) have Maple software installed, and in 
most places you can find both the earlier and latter versions.  The University bookstore sells a student 
version of Maple 12 ($130), which you may wish to purchase at some point, although it is not at all 
necessary to do so for Math 2250.

     When you open any of these Maple versions you can find a "new user’s tour" in a "help" window, 
and we recommend you take this tour to get an overview of Maple’s capabilities.  From then on, you will 
learn to use Maple the same way you learned to use Microsoft Word, i.e. by using it, using the help 
features, and asking friends, lab assistants, TAs and teachers when you get stuck.  We are also be 
running Maple introductions sessions specifically for this course, Math 2250, and you might be in one of 
these sections even as you are reading this document.  The currently scheduled sessions (we may add 
more) are:

Saturday August 30:  PCLab 1735, in Marriott MMC,   2-3 pm.
Tuesday September 2:  LCB 115, 11:50-12:40 and 2:30-3:20

Wednesday September 3:  LCB 115, 10:45-11:55.



     These sessions are first-come, first-serve, and about 30 people can fit into any particular session.

The Math 2250 projects can be done in any of Maple 8, 11, 12, and most instructors will also accept 
Matlab versions of your answers.  But, most Math Department support for these projects will assume 
you’re using Maple.

............................................................................................................................................

1)  Computer Labs on campus, and logging on/off:
     There are many labs on campus, follow the link  http://www.it.utah.edu/services/connected/labs.html .  
Most of these labs have Maple software, and in most of these labs you log on using your University ID 
and password, i.e. the same way you log on to register for courses, get transcripts, etc.  For example, if 
you are using the MMC labs this is the way you log on to your computer.  It is generally true that when 
you log off a student computer on campus, you should not turn off the computer.

Math account name/password exception:
     One important exception to the universality of your uid/password for logging on to campus 
computers is the Math Department computer system, http://www.math.utah.edu/ugrad/lab.html.  All 
students taking Math courses are assigned a Math Department login name and initial password that are 
NOT the same as their UID and University password.  The undergraduate walk-in computer lab is 
located in the Rushing Math Student Center, located underneath the plaza connecting JWB to LCB.  
There is also a computer classroom in LCB 115, where some introductory tutorials are held. Useful 
information about most aspects of the lab can be found by following links from the Math Department 
web pages like the one above, or the precurser directory  http://www.math.utah.edu/ugrad .

     If you’re working on the Math Department system your login name will be of the form c-azbc, 
where ‘az’ is first letter- last letter of your last name, and ‘b’,‘c’ are your first, and middle initials, 
respectively.  For example, if your name is Ulysses Attila Eratosthenes, your login name will be c-esua.  
(Many people have the same initials, so to ensure your login name is unique, a digit may be added after 
the initials, eg.  c-esua1, c-esua2, ...).  For people with more complex (eg.  hyphenated names) only the 
first character of each name is used.  

     Your initial password will be the letters as in the login name, followed by the last four digits of your 
University ID number (e.g., if your UID is 123456789 and your login name is c-esua, then your 
password is esua6789) or if the login name is c-esua2 the password is still esua6789).  You should 
change your password if it’s still the default one. To do so, log in, open a terminal window using a 
mouse or icon selection (depending on the operating system you’ve logged on with), then type 
‘‘passwd’’ (followed by RETURN/ENTER).   Ask a lab assistant how to do this if you’re doing this 
tutorial on your own and are confused.  

     If you previously took a math class and used our system, for example if you did "webworks" 
homework, then your old account may still be active, with the last password you used. If all your efforts 
to log on fail, ask a lab assistant for help.

     Don’t forget to log out when you’re done.  Never turn off a Math Department computer.     

............................................................................................................................................



2)  Opening a browser, maple, etc:    
     Your browser choice depends on your operating system and personal preferences.  We do not 
recommend the Microsoft browser Internet Explorer, because when you try the "Open URL" option 
from Maple, in order to download a Maple file from the internet,  it doesn’t seem to be compatible with 
Explorer.  Mozilla and Firefox seem to work well with this option, and with the second way of using 
Maple files you find on the internet, which is to first download them, and then open them from Maple. 

     Maple versions 8, 11, 12 may appear as icons on your computer desktop and perhaps the icon will 
contain a picture of a maple leaf.  Alternately, you may open Maple with a terminal window command 
or by searching directories. If you’re not sure how to find and open Maple, ask a lab assistant.  In the 
MMC PC labs the Maple software is in the "Class Software" directory.

............................................................................................................................................

3) Maple:   
     If you are starting the tutorial at this point, we assume you have opened Maple version 8, although 
you may be using Maple 11 or 12, as well as a web browser.

     Maple is partly just a very fancy calculator; it can do practically any undergraduate mathematics 
computation or symbolic manipulation.  You can write programs in Maple and draw pictures as well. 
But you can also use it to create documents which mix text with computations, and you can export 
Maple output to other software to create interesting documents.

     If you are doing a homework assignment you can intersperse text with computations using the 
toolbar:  to get a computation prompt click on the ‘‘[>’’ box near the top.  To insert text click on the 
‘‘T’’ box.  Or you can change command fields (starting with "[>") into text fields by putting the cursor 
into them and then choosing "T".  You can use the mouse to cut, paste, and edit a document.  You can 
change fonts, formats, and use other standard text editing tools by choosing appropriate menu items.  
This document you are reading is a Maple document even though it is largely text.  You will learn by 
doing - and by asking your neighbor or the lab assistant.

New User’s Tour and more:  
     Under the Help button at the top right of your Maple 8 window you will find the choice "New User’s 
Tour".  This is a good way to learn generally about what Maple can do.  After making this menu choice 
Maple may hide the beginning of the tour behind other active windows;   use the "Window" menu item 
to bring the tour window to the front.   If you wish you can explore now, or you can continue with the 
Math 2250 notes below and come back to the tour later.  To close the new tour (or any other top 
window), use the ‘‘close’’ option inside the ‘‘file’’ menu item.  To keep the tour open but bring another 
window to the front, use ‘‘window’’ menu item.

     Another good introduction to Maple is located at http://www.math.utah.edu/~gardiner/Intro.mws.  (If 
your computer is appropriately configured clicking on this hyperlink will open your browser and go to 
the indicated URL.  You can then save the file to your computer, and then open it from Maple if this 
does not happen automatically.)  Alternately, if you have a browser open, you can open Maple files 
directly off the internet by using clicking successively on  File -> Open URL, in the Maple menu items 
at the top of the Maple window, and pasting or typing the desired URL into the dialog box which 
appears.  



Entering Maple commands: 
     To give you a brief taste of what Maple can do, we will try a few commands.  Move your cursor into 
the "Untitled" (new) Maple window which you created in step (2).  Commands begin on  lines having  a 
command prompt ‘‘>’’, and should be ended with either a semicolon ; or a colon :  If you end with a 
semicolon you will see visible output, if you end with a colon the output will be suppressed even though 
the command is executed.  Maple will not execute a command until you type the ‘‘return’’ or ‘‘enter’’ 
key.  If you have a multiline command to enter use ‘‘shift-return’’ to change lines without 
executing. 

     If you incorrectly align parentheses or brackets, or do something else which makes your command 
unexecutable you will get a ‘‘syntax error’’ message and Maple will try to point out your mistake with 
the cursor and cryptic diagnostic phrases.  After a while you will become good at fixing these mistakes 
but they can be annoying at first.  Spaces are ignored in Maple, so you may use them to make input 
easier to read.  You can enter explanatory comments in a command line by inserting a ‘‘#’’ to the left of 
the comments; Maple ignores any text after the #.  Sometimes this is more informative then entering 
nearby explanatory text, especially if you are explaining various steps in a subroutine.

    Now, let’s try some commands. (You may try just the math commands, the editorial comments were 
only added to explain what the particular commands are illustrating ! )  Check that you understand what 
each command is doing.

> 3+4; 4+5: 6 * 7;     #one of these computations will not be shown

          #even though all three will be done, illustrating the 

          #difference between a semicolon and a colon

                 

> (3+4)7;       #if you want to multiply you must use *, so after

          #trying the command as given, insert a * to fix the

          #resulting syntax error.  You can execute a line or

          #execution group (bracketed on the left) if

          #your cursor is anywhere in it. You can move the

          #cursor with the mouse or the arrow keys. Maple will

          #try to put it in a good place if it detects an error.

Error, unexpected number


> (3+4)^2/7; 3+4^2/7; evalf(3+4^2/7);  #the evalf  command gives a 

          #decimal approximation instead of an algebraic 

          #expression. Notice that if given a choice, Maple 

          #computes powers first, then multiplies and divides, 

          #and finally adds or subtracts.

> diff(x^2,x);  #‘‘differentiate x^2 with respect to x’’
> diff(exp(sin(x))*x^3,x);  #a harder differentiation problem

         #you should get output:

+( )cos x e
( )sin x

x3 3 e
( )sin x

x2

> f:= x-> exp(sin(x))*x^3;  #this is the syntax for defining a 

         #function, in this case the function we just 

         #differentiated

> diff(f(x),x);         #should get the same answer as before.  
> int(t^2*exp(t),t);   #‘‘integrate (t^2)*exp(t) with respect




          #to t’’ (Maple doesn’t put in the integration constant.)
> int(t^3*exp(sin(t)),t);  #this shows that Maple is not God, you 

          #will get

d
⌠

⌡
 t3 e

( )sin t
t

>           # since if Maple can’t find an elementary function 

          #antiderivative it just echos what you put in.  

> evalf(int(t^3*exp(sin(t)),t=0..1));  #But you could do

          #a definite integral (numerically) even if Maple

          #can’t compute an elementary antiderivative

> Pi;exp(1);evalf(Pi);evalf(exp(1));infinity;

          #some important numbers

Downloading Maple documents:
     This xeroxed tutorial is available online in several formats, if you follow the links from Professor 
Korevaar’s 2250-1  Maple homepage at http://www.math.utah.edu/~korevaar/2250fall08.   Files with 
suffix ".mws" or ".txt" can be downloaded from your browser and then opened from Maple. 

     Alternately, if you know the URL you want, you can use the "open URL" file option on most 
systems.  Do this now, for this document’s URL, 
http://www.math.utah.edu/~korevaar/2250fall08/2250mapleintro.mws .  Maple should download and 
open the document, and now you can follow the tutorial from your computer instead of from your hard 
copy - so start doing so.

    Sometimes, if you have several windows open Maple will put the wrong one on top.  Use the Window 
menu item to move between windows.

Making new files which mix text, commands and output:
     From the "File" menu item, create a new worksheet.(It will start out being called Untitled(2).mws or 
something like that.  The first time you save this file you can pick any name you want, as long as it ends 
in .mws, for Maple worksheet. (Maple 11-12 files have the suffix .mw.  You cannot open a .mw file 
from Maple 8, but you can open a .mws file from Maple 11-12.  To be able to read a file you’ve been 
working on in Maple 11-12 in Maple 8, make sure to save it as a .mws file ("classic") when working in 
the higher-numbered version.

     In your new worksheet turn the command field into a text field by putting your cursor into it, and then 
using the‘‘T’’ menu item. You can usually erase the annoying brackets around text fields you create this 
way, by highlighting them with your mouse and then typing the "delete" key.  Type in the title ‘‘My first 
Maple worksheet’’ (center it with the menu option on the right side of the toolbar), as well as your name 
and today’s date. When you are doing your Maple projects your instructor may expect you to  hand in 
more than a page of computations: You will likely be expected to add text explanations of what you’ve 
been doing.  In general, if you move your cursor to a command field and the press the [> button with 
your mouse, Maple makes a new command field directly below it.  If you move to the new command 
field and press the T button you will have a text field into which you may write, using the rudimentary 
word processing tools on the Maple menu bar.



     Use your mouse to copy the following sequence of commands from this worksheet into your new 
one.  Paste into a command field.  (Successive lines were entered here without execution by using 
shift-return at the end of each line.)
> restart:  #clear all current definitions from memory 

          #(regardless of which window was open when 

          #the definition was made).

with(plots):  #load plotting library

plot(x^2,x=-1..1,color=red,title=‘my first parabola‘);

          #use ‘ quotes, not ’ or " ones

     After pasting, execute this command field in you new window.  By clicking on the plot you are able 
to rescale it and avail yourself of various new menu options.  You could export this plot to other 
documents as well.

Saving Files:
     It is always a good idea to save your maple file periodically.  Save all of your documents - this one, 
which I called 2250mapleintro.mws (you can change the name if you want), as well as your untitled 
documents. Use the tool bar, using the "save" option under the "File" menu item. The first time you save 
a new file, and any time you use the "save as" option, you will be asked to name your file and say where 
you want to keep it.  You name it in the left part of the box, being careful to keep the suffix ".mws" so 
that Maple knows this file is a Maple Work Sheet.  If you’re working on a PC, you can use the directory 
structure to save your file whereever you want.
  
   If you are on the Math system, your directory is probably new you likely haven’t made any 
subdirectories yet (unix command mkdir, in a local window), but as you create more files you may wish 
to organize where you save them using the tree structure of  Unix directories, which you can follow in 
the right side of your saving box.  You use various UNIX commands in your local or terminal window to 
organize your directories.  For more information about this,  go to 
http://www.math.utah.edu/computing/unix/unix-commands.html

     It will probably happen some time that you will crash Maple long after your last save.  This will not 
make you feel happy but will teach you an important lesson.  
    
Printing:
     This depends on which system/computer you are working on.  Ask a lab assistant for help if you 
don’t know how to do this.

Execution Groups:
     You can modify the text and input using the toolbar and menu options.  You will notice many 
brackets on the left of the document.  These are execution groups.  Maple will execute everything in one 
execution group at once, and then move the cursor to the next execution group.  You can create large 
execution groups by highlighting sections of a document, using Edit->Split or Join->Join Execution 
Groups.  You can remove brackets by highlighting them with the mouse and deleting them with the 
delete key or the menu option.  And you already learned how to insert new prompts or new text 
wherever your cursor is, by using the [> and T buttons on your toolbar.

4)  Warm-up problems:
If you are in Professor Gustafson’s Math 2250-2 section, you will be handing in a warm-up Maple 



project.  If your instructor is not requiring that you hand this project in, we still recommend that you do 
it.  Professor Gustafson’s Maple page is at the URL 

http://www.math.utah.edu/~gustafso/f2008/2250mapleF2008.html
and the warm-up project is the first one, entitled "maple Lab 1 fall 2008 pdf".  Read this .pdf document 
from your browser and try create the requested output.  You can use Professor Gustafon’s hints.  
Alternately, you can practice using the help windows to find commands related to answering his 
questions.  (You may end up finding the commands he recommends, but if you practice finding them on 
your own you will also be practicing learning how to use Maple.)

Hint:  Students often approach the task of reading mathematical material as if they were reading a novel; 
they sort of skim along quickly.  That approach  is O.K. to get an overview, but in order to have a chance 
at real understanding you must be prepared to proceed much more slowly, sentence by sentence and 
thought by thought.  Otherwise you will almost certainly find yourself partly lost after several 
paragraphs and completely lost after several more.  (This might happen anyway.)  If you are working 
properly it can easily take half an hour  to read through one page of mathematical text.  This takes a 
certain amount of discipline, patience, and practice.  With the Math 2250  computer  projects there  is the 
added temptation of having Maple execute  commands in successive command sections by repeatedly  
hitting  the enter (return) key, without pausing to digest the interlaced text or the meaning of the 
commands.  There is a seductive appeal in having  this capability.  Resist it.


